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Important Information:

Please carefully read the email you receive upon booking this
experiment for further information. We recommend to use
the literature given in the link for course preparation. The
literature contains the neccessary theory of operating a trans-
mission electron microscope.
Section 3 will help you in your prepartion especially to find
the necessary information from the literature. The tasks in-
tend you to think about and discuss the main topics of this
course. Perfect answers and correct solutions in every detail
is not necessary to attend this course successfully.
Furthermore we recommend to use the image program Fiji
for your analysis. Notice the information in appendix B con-
cerning Fiji.
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1. Introduction

Transmission electron microscopy has in recent years developed into a – somewhat
– versatile tool for physical as well as biomedical sciences. The basic interaction
between electrons and sample, i.e. the interaction with the atoms in the sample
consisting of atomic nuclei and electrons, is well understood and can be described by
theories for the elastic electron-nucleus, and the inelastic electron-electron interaction
(cf suggested literature, e.g. Williams and Carter [Wil09], Reimer and Kohl [Rei08],
R. Erni [Ern10], J. Rodenburg [Rod18]). However, necessary instrumentation for
high resolution, atomic imaging in a transmission electron microscope (TEM) had
to be developed in a long process culminating in the correction of lens aberrations
realized in the last two decades. The correction of lens aberrations such as spherical
aberration, coma, and more recently also chromatic aberration has allowed scientists
to directly visualize columns of atoms in crystalline material and also individual car-
bon atoms in graphene [Hai98]. Figures 1.1 and 1.2 were adopted from the SALVE
web-page (http://www.salveproject.de), a recent collaborative project for optimizing
imaging and electron spectroscopy on carbon-based materials.
In material science today, the TEM is used for high-resolution imaging as illustrated
here, but also for studies based on more conventional electron scattering experiments,
i.e. electron diffraction on crystalline material, as well as for analytical studies. Such
studies utilize the special nature of inelastic interactions between the incident elec-
trons and the electrons in the sample. In general, all these techniques are employed
to obtain information about the structure of a material and its localized electronic

Figure 1.1: Strontium titanate as a typical materials science sample where in the past it
was not possible to image individual columns in an oriented and thinned specimen. (A)
shows the known atomic structure, which has been imaged in the past in conventional
microscopes as shown in (B). Such images could only be interpreted by advanced simula-
tion of image contrast from known models. (C) and (D) show images and more modern
simulations of aberration corrected imaging. Figure adopted from SALVE web-page.
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2 1. Introduction

Figure 1.2: Examples of conventional (upper row) and aberration corrected images (lower
row) of a mixed crystalline/amorphous Si specimen. The direct imaging in the aberration
corrected microscope shows the individual Si atom columns of the crystalline area (left
part of the picture). This cannot be resolved in the conventional image. Figure adopted
from SALVE web-page.

properties. Imaging resolution is very often in the 1Å to even sub-Å range. The
resolution of the analytical signal is normally reduced to the typical delocalization
of the inelastic interaction in the sample.
In biomedical electron microscopy, the situation is quite similar: With advances in
sample preparation and, in particular, constantly improving electron imaging de-
tectors, it is now possible to image biomolecules such as e.g. proteins or protein
complexes in their 3D structure at a quasi molecular level, sometimes in the range of
3 to 5 Å – more routinely in the range of 6 to 8Å. Figure 1.3 shows a typical image
of such a «6Å study» of the actin-myosin model complex, i.e. the force producing
protein complex, which works in our muscles.
If one compares the images of a materials sample with the images of the actin myosin
complex one clearly realizes, that the level of resolution and atomic detail is com-
pletely different. The reason for this is very simple: The electrons used for imaging
also damage the sample. This is obvious from the physics of inelastic interactions,
their energy transfer and the fact, that inelastic interactions are more probable than
elastic interactions for light material. For large Z materials (Z> 26), elastic inter-
actions start to win. Biomedical samples, which are prepared in a glassy, vitried
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Figure 1.3: (A) Images acquired by transmission electron cryo microscopy of F-actin dec-
orated with myosin Va motor domains with truncated lever arm, in nucleotide-free Rigor
state. The defocus value is 1.7µm and 5µm for the insert, respectively. (B) The recon-
structed density map of the nucleotide-free complex shows the typical helical symmetry of
the filamentous actin-backbone. Shown are six actin molecules in their ribbon represen-
tation (light yellow) and four myosin motor domains (blue). Images from our own paper
[Wul16].

aqueous buffer layer of about 50 to 100 nm thickness, are simply «boiled away» by
our electron beams. Thus, images have to be taken at lower magnication and lower
electron dose, which decreases resolution and increases noise.

What will you learn from this experiment?

As you might expect, TEMs which deliver sub-Å resolution or allow the imaging of
a frozen sample at liquid nitrogen temperature are very specialized, expensive, and
most of the time used for our research. A microscope – as small as the one used here
in our practical course – will not have all this expensive instrumentation, but will
get you acquainted with some very important physical facts, which we in our daily
research still have to be aware of. Familiar topics in this respect are the optimal opti-
cal alignment of an imaging system in particle optics, basic imaging properties when
working with a particle beam, the recording of an image and basic image processing
steps. Also, electron diffraction experiments can be performed with our microscope,
and very fundamental experiments to test the coherence of an electron beam and
how it can be inuenced by different beam forming parameters. In the end you should
have a first feeling – and also the physical basis for it – what it takes to set up a
microscope optimally and how to tune it for highest performance. One of the «holy
grails» of transmission electron microscopy, the Contrast-Transfer-Function (CTF),
should then be something, which has lost its legendary aura. While we provide a
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guideline for experiments with our samples (which we provide as well), we also will
give you samples for «free microscopy». This will be tissue samples from biological
specimens, plant root or mouse muscle prepared with different protocols. Besides
all the proposed experiments, documentation, suggested reading, and discussion, we
would like to encourage you to simply «play around» with these samples – following
the rule that «one can see a lot just by looking». To make this worthwhile – however
– we will discuss your images (and your documentation of this free microscopy) with
you and also explain a bit of the biology of the samples.



2. Outline of Experiments

2.1 Day 1: Introduction, Basic Operation and First Exper-
iments

Theory and basic operation of the transmission electron microscope (TEM)

• Experiment 1.1: Acquire a defocus series of the myelin sheath in a mouse
muscle. First insights into the effect of the Contrast Transfer Function.

• Get to know the lens system of the microscope.

• Experiment 1.2: Determine the effect of a) over- and underfocus, b) astigma-
tism, c) coherence, d) centered objective aperture and e) different magnification
settings on the image quality.

• Removement and insertion of the sample holder. Alignment of the microscope.

• Magnification Calibration: Record images of a standard sample for magni-
fication calibration.

2.2 Day 2: Diffraction, Bright- and Darkfield Imaging

Diffraction Experiments and Basic Principles of Bright- and Dark-Field
Microscopy

• Understand the formation of diffraction patterns and which information they
provide about the sample.

• Experiment 2.1: Acquire a diffraction pattern of a thin film (Au) at 150mm
or 250mm camera length.

• Understand different imaging methods in the TEM using the diffraction mode.

• Experiment 2.2: Acquire bright- and darkfield images of MgO crystals.

5



6 2. Outline of Experiments

Elective Experiments for TEM or SEM

You can choose one of the following experiments depending on what you want to do
the next day:

• Experiment 2.3: Record a second DP of the gold film at another camera
length for calibration purposes.

• Experiment 2.4: Take images of one or two provided biological samples to
compare the images with the according SEM images.

2.3 Day 3: Elective Experiments TEM or SEM

You can either continue with experiments at the TEM or the SEM.

Further Experiments at the TEM (diffraction, bright- and darkfield imag-
ing

• Experiment 3.1: Vegards law: Acquire diffraction patterns of alloys (Au/Pd
or Pt/Pd) at the camera lengths you used the previous day.

• Experiment 3.2: Acquire a defocus series of a catalase crystal to further
understand the effect the Contrast Transfer Function on the image.

• Experiment 3.3: Measure and use the periodicity of a catalase crystal to
calibrate higher magnifications of the TEM.

Elective Experiments at the SEM (biological samples)

• Get to know the basic operation of a SEM (magnification, focus, wobbling,
astigmatism correction).

• Experiment 3.4: Acquire images of samples that you already investigated
with the TEM for comparison.

• Understanding the differences between TEM and SEM. Explaining advan-
tages/disadvantages of both methods.

• Experiment 3.5: Acquire images of biological samples you can’t image in the
TEM.



3. Course Preparation

Work on the following tasks and be prepared to discuss them over the course of the
three days.

3.1 The Imaging system of a TEM

The beam paths in electron optics can be drawn analogous to light optics. Chapters
6 and 9 of [Wil09] may help you working on the following tasks.

1. Name reasons, why we are using microscopes.

2. Consider two scattering points and one non-scattering point (vacuum) located
in front of an ideal lens as depicted in figure 3.1 at the end of this section. You
can use the figure for the following constructions.

• Define the image plane of the lens at an arbitrary, but reasonable place
behind the lens (arbitrary magnification).

• Construct the image of the given objects by using the centre of the lens and
the previous defined image plane. You may benefit from your knowledge
of optical geometry.

• Assume that all electrons (scattered and non-scattered) passing a point
are moving through the according image point in the image plane as well.
With this construct the beam paths of non-scattered (0 ◦) and scattered
(α) electrons at the following angles α in different colors: 40 ◦, 20 ◦, −20 ◦,
−40 ◦

• Mark characteristic points and planes on basis of your constructions and
explain, why they are characteristic.

• Mark in the same figure the location of the following apertures and explain
their purpose.

– Condenser aperture (CA)
– Objective aperture (OA)
– Selected-area aperture (SA)

3. Explain the purpouse of the following parts in a basic TEM setup: Condenser,
Objective, Projective.

7



8 3. Course Preparation

3.2 Contrast Transfer Function

Sections 6.5 and 28.7 of [Wil09] may help you working on the following tasks.

1. Explain «contrast».

2. Explain the difference between the following contrast mechanisms and indicate
the ones used for imaging in a conventional TEM.

• absorption-contrast

• aperture-contrast

• phase-contrast

• filter-contrast

3. Explain in a few sentences the difference between «Fresnel» and «Fraunhofer»
diffraction.

4. Name possible lens aberrations and how they can be compensated.

5. Explain «Scherzer-Focus» and its significance. (No calculation needed! This
can be found in section 28.7 of [Wil09])

6. You will have to calibrate all magnifications of the microscope in real space and
fourier space of an image showing a standard sample. One calibration method
is described in Chapter 9 of [Wil09] (p. 164f).

• Download the image «Calibration.tif» from the link showing an image of
a standard specimen - so called «cross grating» (2160 lines/mm) - with
latex beads on it (black dots with ∅ 0.261µm).

• Open the image in an image program (e.g. Fiji) and get an idea, how to
measure lengths and intensity profiles with this program. You will need
that for data analysis later on. Helpful features of Fiji can be found in
appendix B.

• Find out what measurements need to be done in real space and in the
fourier transformation of the image (distance real, diameter latex beads,
distance FFT) to calculate the pixel size in the image.

• Argue, why the magnification is calibrated, if you know the pixel size of
all magnification settings and estimate the error you would expect from
your measurements.
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3.3 Diffraction, Bright- and Darkfield-Imaging

Chapters 11 and 12 of [Wil09] may help you working on the following tasks.

1. Write down the «Bragg condition».

2. Describe, what kind of diffraction pattern you would expect from a single
crystal and therefore for a polycrystalline sample.

3. Write down «Vegard’s law» and calculate the lattice parameter for Pt/Pd and
Au/Pd (each 80/20).

4. You will have to calibrate the camera length of the microscope. As for the
previous calibration a suitable method is described in Chapter 9 of [Wil09]
(p. 165f).

• Download the image «DiffCalib.tif» from the link. This is an image stack
containing 8 images of a polycrystalline gold diffraction pattern.
• Open the image stack in an image program (e.g. Fiji) and use the «Z-

Project» function of Fiji (see appendix B) since this will help you to
present your data later on.
• Use the «Radial Profile» function in Fiji to calibrate the camera length.

Estimate the error, you would expect from your measurements.

3.4 Scanning Electron Microscopy (SEM)

The following preparation part only needsto be done, if you choose the elective
experiments for the SEM. You can do after the second part of the course, after you
decided to go for the SEM experiments. Chapters 1 of [Rei93] may help you working
on the following tasks.

1. Name the principle differences between TEM and SEM.

2. Explain the image formation in the SEM in contrast to the TEM.

3. Describe qualitatively the interactions between the primary electron beam and
the sample, that are essential for imaging in the SEM.

4. Name the resulting electrons from these interactions, which can be detected in
the SEM.

5. Name the limiting factors for the image resolution in the SEM and compare it
with the resolution limit in the TEM.
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3.4. Scanning Electron Microscopy (SEM) 11

optical axis

ideal lens

Figure 3.1: Construction of scattered and unscattered beam paths through an ideal
lens. The filled dots in front of the lens represent scattering objects, while the small circle
represents a non-scattering object (vacuum). The objects are illuminated homogeneusly
by coherent electrons, that move parallel to the optical axis of the lens. The cross on the
lens marks its center.
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4. Experimental Procedure

Always make notes of the imaging conditions at which you acquire data/images.
Since you want comparable data or be able to reproduce it in the future, this is a
very important experimental practice. For this purpose a spreadsheet template
is provided, where you can enter all important imaging parameters.
Decide who operates the microscope and who enters the microscope parameters. You
can switch during the course.

4.1 Day 1: Getting Started

All important components (apertures, valve V3,...) and knobs are indicated in the
figures 4.1 and 4.2.

1. The microscope will be turned on and adjusted by the instructor for the first
experiment.

2. Let the instructor show you the basic operation of the microscope. During this
course you will understand, what the single knobs are doing in the microscope.

The aim of the first experiments is to see the influence of the microscope settings on
the image quality. We will start with the focus of the objective lens.

Experiment 1.1: Visualizing the myelin sheath of a mouse muscle

1. Acquire a so called defocus series of the myelin sheath in a mouse
muscle and take a close look at the membranes of the myelin. Use a focus range
given by the instructor in steps of 0,1 and describe significant differences in
the images.

2. Compare the power spectrum (FFT) of all taken images and describe, how it
changes. Do yo recognize the «Thon Rings»? Discuss these with the instructor,
what the power spectrum already tells you about the image quality. You should
be able to explain the influence of the focus settings on the image in real and
fourier space.

3. For your documentation: Save the images as stack. Don’t forget to note
the microscope parameters in an excel sheet. Save the template sheet as a new
file containing the actual date and your name.

13



14 4. Experimental Procedure

Figure 4.1: The ZEISS EM10EL. Condensor aperture (CA), objective aperture (OA),
selected-area aperture (SA), as well as important components are indicated.

Experiment 1.2: Influence of different microscope settings on the image
quality

a) The effect of over- and underfocus

1. The projective of the microscope is set at an magnification around 20 kx. Make
sure the camera is removed from the beam path and change to a smaller
magnification of 400 x (Low MAG).

2. Look at the fluorescent screen in low-mag-mode. You should be able to identify
the embedded muscle sample.

3. Go to a sample area without the resin sample, in which the muscle is embedded,
containing only holes of the carbon holey film .

4. Go back to a higher magnification of 30 kx, activate the «rabbit mode» of the
camera and carefully insert the camera. You should now see an image of the
holey carbon film.

5. Center a small hole (it should fit well on the camera) with the goniometer using
the camera in «rabbit mode».
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6. Toggle the FOCUS knob and observe the image.

7. Describe how to determine from the image (Fresnel Fringes) and the
power spectrum (Thone Rongs) that your sample is in focus and
adjust the microscope accordingly.

8. For your documentation: Make sure you have around 6000 counts
and take images of holes in focus, over- and underfocus. Explain how
you can discern them.

b) The effect of astigmatism

1. Make sure your sample is in focus as you learned in the previous step.

2. Set one of the objective stigmators (OBJ STIG) to maximum, which induces
astigmatism to the image. Describe how the image changed.

3. For your documentation: Record an image (6000 counts) of a hole,
which shows astigmatic characteristics. Explain the effect by describ-
ing the different appearance of the «Fresnel» fringes in the image.

4. Reset the Objective Stigmator (OBJ STIG - RECALL).

c) The effect of coherence

1. Make sure your sample is in underfocus, so that you can see the «Fresnel»
fringes.

2. Record an image using a small SPOTSIZE and short exposure times. Be
careful not to overexpose the camera but make sure you have around 6000
counts. If neccessary increase the magnification.

3. Increase the SPOTSIZE (values of 20.0 or higher) and take an image. You
will need a longer exposure time, since the countrate will drop. You might not
reach the 6000 counts, not even at 7500 ms.

4. For your documentation: Describe the differences between images
at small and high SPOTSIZE. Explain them and take the «Fresnel»
diffraction into account.

d) Aperture contrast

1. Increase the sample illumination (go back to a smaller SPOTSIZE) and bring
the image into focus).
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2. Make sure the camera is REMOVED firstly and go to diffraction mode
(DIFF/IMG). Insert and center the first objective aperture (OA). The
handling of the aperture knobs is described in figure 4.3.

3. Go to image mode (DIFF/IMG) and carefully insert the camera in «rabbit
mode». Take an image with around 6000 counts. Compare the taken image
with centered OA and the according image from part a) in focus.
Describe the difference between them.

4. For your documentation: Explain these differences from what you
have learned about the beam paths in a TEM in the course prepa-
ration. You can take an additional image with the smallest OA
centered in diffraction mode.

e) Magnification

1. This experiment can be included into experiment 1.3.

2. If not already done in the previous step, change the magnifiction of the micro-
scope and take images of at least two different magnification settings. Always
remove the camera, if you switch to lower magnification settings!

3. For your documentation: Describe what happens when you switch
between different magnifications and explain your observation.

Magnification calibration with a cross grating (optional)

1. Follow this procedure if there is time left at day 1. Otherwise the instructor
will give you images for the magnification calibration. You will need these to
measure distances in your images and add scalebars to them.

2. Turn off the filament and let the instructor show you, how to change the sample
holder.

3. Insert the sample holder containing the cross-grating replica.

4. Let the instructor check the alignment of the microscope. Take a look at it
since you will do this from now on.

5. You should see a cross-grating (2160 lines/mm) with latex spheres (∅ 0.261µm).

6. Take images of the cross-grating at each (high mag) magnification setting
(3 kx to 250 kx).
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• Make sure the sample is in focus. Remember how you deter-
mined that the sample is in focus.

• At higher magnifications, make sure to get as many straight lines as possi-
ble on the camera (use the «rabbit mode» if necessary). Sometimes there
are irregularities in the cross-grating that will make it hard to get a good
calibration. Also try to get good images of the spheres to check your
calibration.
• You will have to adjust the spotsize and exposure time as you go to

higher magnifications.

7. Talk with the instructor how to measure the pixel size from the real space and
the power spectrum (FFT) of the image using Fiji.

8. Understand how the power spectrum is calculated and qualitatively
describe the differences in the power spectrum at lower and higher
magnification.

9. You should now have at least one image of the cross-grating and latex spheres
for each (possible) magnification.

Finishing day 1

1. Make sure you have recorded and saved all images for your documentation.

2. When done remove all apertures and close V3.

3. Remove the camera from the beam path.

4. Turn off the filament and then the high tension.

5. Remove the sample from the beam path.

6. Insert the sample you will investigate tomorrow (Au thin film).

7. When you have saved all your images (use a clean USB Stick), shut down the
camera computer.

8. Turn off the microscope in the microscope software. (Make sure the camera
computer has shut down completely.)

9. Shut down the microscope computer.

10. Finish Day 1.



18 4. Experimental Procedure

Figure 4.2: Control panel for the ZEISS EM10EL.

4.2 Day 2: Diffraction Experiments

Firstly you will learn to align the microscope, since this is the everyday procedure
in electron microscopy. Afterwards you will get to know electron diffraction and
understand, how different apertures can be used for material investigation.

1. Turn on the microscope as described in the according section in the «Alignment
Procedure EM109EL» document.

2. You can use the time the system needs for pumping to talk with the instructor
about electron diffraction before you start over.

3. You will be measuring at 80 kV acceleration voltage and No. «2» emission
settings in the software (around 5 to 6 µA emission current) unless otherwise
stated.

4. Make sure no apertures are inserted.

5. Use the «Alignment Procedure» to align the microscope and record back-
ground and flatfield images for the camera.

6. Insert the first condensor aperture as described in the «Alignment Proce-
dure».

Get to know diffraction

1. Make sure the Au sample is inserted to the microscope.

2. Enter a small magnification in low-mag-mode and screen the sample to find an
area containing the sample film.
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Figure 4.3: (Condensor) aperture drive. Turning 1 will let you insert or remove the
different sized apertures. The black knobs (2 and 3) let you move the aperture in x and y
direction.

3. Increase the magnification of 20 kx.

4. Now make sure, that the camera is NOT in the beam path before you change
to diffraction mode. You should look at the image on the fluorescent screen
first.

5. Go to diffraction mode (DIFF/IMG).

6. Does the observation meet your expectation?

7. Go back to image mode (DIFF/IMG).

8. Insert and center the smallest selected-area aperture (SA).

9. Go back to diffraction mode (DIFF/IMG).

10. Describe and explain the differences.

11. Insert the biggest objective aperture (OA) and cover the central beam, so
that you can use the camera in «rabbit mode».

12. Activate the «rabbit mode» and carefully insert the camera into the beam
path. Make sure the central beam is still covered!

13. While in «rabbit mode» move the inserted SA back and forth in one direction
while you are in diffraction mode and observe the diffaction pattern (DP) on
the camera. Describe significant differences in the DP between two different
SA positions.
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Figure 4.4: (A) Air lock. Top Arrow indicates direction to turn when opening the air
lock. Bottom arrow indicates the slider which is in parking position on this picture. (B)
Specimen holder and tools. (C) Specimen holder when unscrewing the cap.

14. Take at least two images of the visible DP part at two different SA positions.
It is not neccessary the reach 6000 counts to record a DP. Just check for a godd
signal to noise ratio.

15. If done, remove the camera and switch to another SA of bigger size and center
it.

16. As before take an image of the visible DP part with a bigger centered SA.

17. Explain your observations. Argue, what the selected-area aperture
(SA) is useful for if you consider to record DPs.

Experiment 2.1: Investigating the diffraction pattern of a thin gold film

Record a full diffraction pattern (DP) using the largest OA at a camera length
(CL) of 150mm or 250mm.

1. First decide, if it is reasonable to use a SA before recording the DP.
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2. IMPORTANT!!! Make sure the (000) spot of the DP is NOT on the
camera, but hidden by the OA.

3. IMPORTANT!!! Always remove the camera and use the fluorescent
screen when adjusting the OA.

4. Use a reasonable SPOTSIZE and make sure your DP is in focus.

5. Move the OA around the center of the diffraction pattern to record a full DP
of Au at the chosen camera length (CL). You will need about 6 to 8 images.

6. In your analysis you will load them as an „image sequence“ into Fiji to prepare
it for your documentation later on.

7. Remove the camera if you do not need it any more.

For the next day you have to decide now, which experiments you want to do since
this will influence if you need to change the sample at this stage or not.

SEM: If you choose this option, proceed with experiment 2.2 and afterwards exper-
iment 2.4. On the next day you will observe biological samples in the SEM.

TEM: If you choose this option, proceed with experiment 2.3 before experiment
2.2, so that you don’t need to insert the Au film again. If there is no time left for
experiment 2.3 today, you can perform it tomorrow. Skip experiment 2.4.

In the following experiment you will learn, how the OA can be used for darkfield
imaging.

Experiment 2.2: Bright- and darkfield imaging

1. Remove the camera and turn off the filament to insert the MgO sample.

2. Use the «Alignment Procedure» to make sure the beam is aligned.

3. As in previous experiments investigate the sample in low-mag mode. De-
scribe, what you see.

4. Toggle magnification in high-mag-mode, focus and spotsize to investigate your
sample using the camera in «rabbit mode».

5. Find a sample area containing just a few MgO crystals, if possible.

6. Go to 20 kx or 30 kx and make sure your sample is in focus.
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7. Insert and center the smallest SA on the camera.

8. When done, remove the camera and switch to diffraction mode (DIFF/IMG).
You should see the DP on the fluorescent screen.

9. Insert and center the smallest OA (2nd aperture position).

10. Switch back to image mode (DIFF/IMG) and acquire a bright-field (BF)
image. Make sure it is in focus (use the «rabbit mode» if necessary).

11. In diffraction mode center the OA around a diffracted beam. If you cover
the central beam with the OA you can use the camera in «rabbit mode» to do
fine adjustments. Take an image of the diffracted beam you used for
your documentation.

12. Go to image mode (DIFF/IMG) and acquire a so called dark-field image.

13. Do this for a reasonable number of diffraction spots, and if possible of two op-
posing diffraction spots (Friedel pair). Feel free to go to higher magnifications
or another sample position.

14. You should have acquired at least one BF image of a sample area
and a few DF images from opposing and non-opposing diffraction
spots. Later in your documentation you should be able to explain
and discuss your observations.

15. Remove the SA and the OA.

Elective experiments

Choose one of the following experiments:

Experiment 2.3: Record another DP of the thin Au film at 150mm or 250mm
camera length depending on which camera length you chose previously. You
can proceed as described in experiment 2.1. This you will need later on to
calibrate both camera lengths of the TEM.

Experiment 2.4: Choose at least one of the provided biological samples and
insert it to the TEM. Take images of the regions of interest (e.g. amoeba and
virus). On the next day you will compare them with images taken in the SEM.
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Finishing day 2

1. When you finished all experiments and saved all images for your documenta-
tion, remove all apertures and close V3. Turn off the filament and then the
high tension.

2. Remove the sample and the camera from the beam path.

3. Shut down the camera computer.

4. If neccessary (by choosing experiment 2.4) insert a sample you need on the
next day. If you didn’t have the time for experiment 2.3 enter the MgO sample
otherwise choose either Au/Pd or Pd/Pt. Note which one you chose.

5. Turn off the microscope in the microscope software. (Make sure the camera
computer has shut down completely.)

6. Shut down the microscope computer and turn off the main switch afterwards.

7. Finish day 2.

4.3 Day 3: Elective Experiments at the TEM or SEM

4.3.1 Elective Experiments at the TEM

1. Turn on the Microscope.

2. Use the «Alignment Procedure» to align the microscope and record back-
ground and flat-field images for the camera.

Experiment 3.1: Investigating Vegard’s Law

1. Make sure, you inserted either a Au/Pd or Pd/Pt thin film into the micro-
scope.

2. Record a full diffraction pattern (DP) as you did for the Au gold thin film in
experiment 2.1 at camera lengths 150mm and 250mm.

3. Do you see a significant difference between the DPs of Au and the sample you
chose?

4. When done, you should have recorded a set of images to create a
full DP for either Au/Pd or Pt/Pd at camera lengths 150mm and
250mm for your documentation.
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Experiment 3.2: Investigating Catalase Crystals

Similar to the cross-grating replica catalase is a standard for magnification calibra-
tion. You can use it to calibrate the high magnifications of the TEM, because the
lattice spacings of catalase are much smaller. More interestingly it is possible to see
the effect of the contrast transfer function at different defocus much better compared
to the investigation of the myelin sheath of a mouse muscle.

1. Remove the camera and turn off the filament to insert the sample holder con-
taining the catalase sample.

2. While you change the sample, explain the purpose of negative stain.

3. Once the filament has ramped up, change the emission setting to «3» in the
software. You should now have a much larger emission current.

4. Use the «Alignment Procedure» to make sure the beam is aligned. After
changing the emission current new background and flat-field images are
needed for the camera.

5. Investigate the sample and describe what you see. You probably have to in-
crease the magnification to see the crystal spacings of catalase. Find a catalase
crystal.

6. Use the OA to increase the contrast.

7. Use the support film to correct the objective astigmatism (Obj Stig) at
high magnification for best results. You might need to use a higher spotsize,
longer exposure times and a sufficient high defocus to see the «Thon Rings»
in the power spectrum. If the «Thon Rings» appear round, the objective
astigmatism is minimized.

8. Choose a (high) magnification where you can see the «Thon Rings» and the
crystal spacings in the power spectrum as well.

9. Change the focus to higher defocus and watch the crystal spacings and the
power sectrum. Describe what you see.

10. Watch the crystal spacings until you realize changes in the image.

11. Observe the power spectrum closely and describe what happens there as well
while changing the focus.

12. Record a defocus series as you already did in experiment 1.1. You may have
to use another focus range!
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• Start at focus and go to higher underfocus (defocus) in order to catch the
changes in the images.

• Take images of your observations.

13. Later on in your documentation you should be able to discuss your
observations.

Magnification calibration with catalase

1. Use the opportunity to take images of the catalase crystal to calibrate the
higher magnifications of the microscope.

2. Bring the catalase crystal into focus. (use the «rabbit mode» if neccessary).

3. Start at a magnification where you first see the catalase crystal spacings (note
the power spectrum). Record images of the catalase crystal spacings.
Do this for all higher magnification settings.

4. When done, you should have defocus series of the catalase crystal and images
of it for each of the magnification settings in which you can see the spacings.

5. Use these images later in your documentation to calibrate the higher
magnification settings. Using catalase the calibration can only be
done from the Power Spectrum of the images.

Finishing Day 3

1. Make sure you have saved all images you need for your documentation and
entered the microscope parameters in the excel sheet.

2. Go back to emission setting No. «2» (5 to 6µA), turn off the filament and
afterwards the high tension.

3. Remove all apertures and close V3.

4. Remove the sample holder.

5. When you have saved all your images, shut down the camera computer.

6. Turn off the microscope in the microscope software. (Make sure the camera
computer has shut down completely.)

7. Shut down the microscope computer.
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8. Make sure you ask the instructor, if someting was unclear.

9. Finish Day 3.

4.3.2 Elective Experiments at the SEM

The Scanning electron microscope (SEM) is located in the BioQuant building 267.

1. The microscope will be turned on and adjusted by the instructor in the begin-
ning. Let the instructor show you, how to toggle focus, magnification, stigma-
tors and the apertures.

2. Get used to the controls and start optimising an image at a programmed sample
position. You can always ask the instructor for help.

Experiment 3.4: Comparison between TEM and SEM

1. Move the sample holder to the samples that you already investigated in the
TEM. You may have to search a bit for the regions of interest.

2. Since you don’t want to damage the region of interest, choose a position next
to it, to optimize the image settings.

3. Iterativly wobble the image and correct for astigmatism to get best results.

4. When done, take a reasonable amount of images and save them. You don’t
need to enter the microscope parameters in an excel sheet since they are saved
in the images themselves.

Experiment 3.5: Investigating biological samples in the SEM

1. Move the sample holder to the sample position of other biological samples and
take nice images.

2. Describe some of the problems you are facing while image acquisition and
explain, why they occur. You should discuss this in your documentation.
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Important! All real space images should contain a scalebar. In order to do this
you need to calculate the pixelsize for the specific image firstly. Afterwards you can
add a scalebar using Fiji (appendix B).
Indicate on your diffraction patterns the used camera length.

5.1 Magnification Calibration

• Create a calibration table containing the following for all magnifica-
tion settings.

– nominal magnification

– pixel size and its error estimation

– real magnification and the resulting error

– method used for the calibration (real or fourier space)

– the sample you used (cross grating or catalase)

– check using the latex beads

• The neccessary information about the standard samples can be found in Ap-
pendix C. The course preparation from the beginning may help you here.

• Appendix B.3 explains how to calculate the power spectrum in Fiji.

• Plot the real magnification from the calibrated pixel size(detector pixel size:
14µm) for each calibration method along with the nominal magnification.
Compare real and nominal magnification of the microscope by a suitable fit
function.

• Discuss the results and possible errors. Argue, why you need different spec-
imens for calibrating all magnification settings by showing suitible images of
the standard samples.

• Use the calibration to print a scalebar in all of the following images and to mea-
sure distances in real space and the power spectrum. Appendix B.1 explains,
how to do this with Fiji. Make sure the scalebars are big enough.

27
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5.2 Judging Image Quality

• Give a short explanation about the formation of Fresnel Fringes in your images.
(No formulas!)

• Explain the effect of over- and underfocus using images of a holey carbon
film. Describe, how the contrast of an image in focus can be increased.
Figure 3.1 from your preparation may help you, since this figure was discussed
in detail during the whole course.

• Demonstrate the effect of astigmatism on an image you recorded of a
holey carbon film. A small schematic drawing may help here as well.

• Show, how coherence affects the image quality by judging the visibility of
Fresnel diffraction patterns inside a hole in a carbon film.

• Give a short explanation, why the image rotates if you switch between the
magnifications.

5.3 Diffraction, Bright- and Darkfield Imaging

• Explain diffraction shortly. Take the Bragg and Laue condition into account
and show, how they are related.

• Explain the effect of an inserted selective aperture on the diffraction pattern
(DP). You should have at least three images showing significant differences.

• Load the images from the DP as a stack into Fiji and use the Z-project function,
to create a nice image of a full DP. How this can be done is explained in
appendix B.1 and B.4.

• Index the diffraction pattern of gold. No calculation is needed here! (See the
table A.1 in the appendix.)

• Explain the contrast differences between bright- and dark-field im-
ages from the MgO crystals. (especially the Friedel pair)

• Mention and discuss all other anomalies you may see in the DF images.



5.4. Understanding the Contrast Transfer Function 29

5.4 Understanding the Contrast Transfer Function

• Measure the spacings between the membranes in the myelin sheath
using the power spectrum of the images. Appendix B.3 explains how to calcu-
late the power spectrum of an image in Fiji.

• Using the power spectrum discuss, whether the measurement is correct. Take
images from the SEM measurements into account, if you did experiment 3.4.

• If you consult the literature, you would find out, that there is no fix reference
value for the distances in the myelin sheath. Discuss, why you would actually
expect this.

• If you performed the elective experiment 3.2, show images of a Catalase crystal
prepared as negative stain sample, and explain the purpose of «negative stain».

• Show the «Thon Rings» in the power spectrum of the myelin sample (and
optional the catalase image) in over- and underfocus.

• Show and explain the influence of the contrast transfer function using the defo-
cus series of the myelin in a mouse muscle (and optional the catalase crystal).
(No formulas, but you can use a digram describing the CTF, if you find one!)

5.5 Investigating Vegard’s Law

This section is only relevant, if you did experiment 3.1.

• Create a nice image of the diffraction pattern of Pt/Pd or Au/Pd using
Fiji. (Appendix B.4)

• Calibrate the camera lengths at 150mm and 250mm using the according
diffraction pattern of gold and Bragg’s law. You can use the radial profile in
Fiji for the calibration measurement (B.5).

• Analyze the diffraction patterns of Pt/Pd or Au/Pd at the camera lengths
150mm and 250mm respectively. From the rings in the DP you can measure
the crystal spacings using Bragg’s law and the calibration of the camera length.
Don’t forget to indicate the errors rising from your measurements.

• Calculate the lattice parameter for the sample you chose using Veg-
ard’s law and compare them with your measurements (Use Bragg’s law). The
ratio used to grow the cystals can be found in the appendix C.

• Discuss possible errors.
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5.6 Comparison between TEM and SEM

This section is only relevant, if you did experiment 3.4 and 3.5.

• Discuss the advantages and disadvantages of imaging with TEM and SEM
respectively. Discuss especially, why some samples can not be investigated in
the TEM, but in the SEM.

• Show and discuss the images from your SEM measurements especially in
comparison to your TEM investigation.

• Explain the occurence of sample charging in electron microscopy and
how this influences your image.

• Discuss, why you didn’t observe charging in the TEM.

• Discuss how you can avoid charging.
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A. Diffraction Gold

h k l d∗ [nm−1] d [nm]

0 0 0 0
1 1 1 4.256 0.235
0 0 2 4.914 0.204
0 2 2 6.949 0.144
1 1 3 8.149 0.123
2 2 2 8.511 0.117
0 0 4 9.828 0.102
1 3 3 10.71 0.093
0 2 4 10.988 0.091
2 2 4 12.037 0.083

Table A.1: Peak positions for gold (Au).
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B. Helpful Features in Fiji

Fiji (Fiji is just ImageJ) is an opensource software for scientific image processing.
You can use it to calibrate and analyze electron microscopy images. Fiji (including
the Radial Profile Plugin) is installed on the CIP-Pool computers.
Download sources and further information can be found on the internet:

• Fiji can be downloaded here for all common used operating systems:

http://imagej.net/Fiji/Downloads

• The Radial Profile Plugin here:

https://imagej.nih.gov/ij/plugins/radial-prole.html

• An extensive documentation for ImageJ in general can be found under:

https://imagej.nih.gov/ij/docs/guide/index.html

B.1 Opening images and scalebars

Single images can be open by drag and drop. You can open several images as one
stack under:

File → Import → Image Sequence.

Fiji cannot read any calibration done by this camera software. Reset the image size
to pixels for each image under:

Analyze → Set Scale → button «click to remove scale»

Here you can enter the results from your calibration as well, by entering the calculated
pixel size in nm, once you know it. A scalebar can be added to your image under:

Analyze → Tools → Scale Bar

B.2 Adjusting Brightness and Contrast

The images you acquired during the experiment will be 16-bit greyscale. Some-
times, especially at higher magnications, the intensity during acquisition was low.
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This might cause your image to appear black at first, since Fiji will use the whole
(gray scale) histogram to display the image. You can adjust the histogram under:

Image → Adjust → Brightness/Contrast

Using the shortcut «Ctrl + C» works even quicker. Pressing the «Auto»-button in
the window often yields to a nice view. After you have adjusted this to your liking,
you can change the type of your image to 8-bit (Image -Type -8-bit). Fiji will then
discard the information that you did not select in the histogram. Changing your
images to 8-bit is sometimes helpful, since they will then take up less disk space.

B.3 Fast Fourier Transforms (Power Spectrum)

If you need to calculate the power spectrum of an image (e.g. for calibration), this
can be done under:

Process → FFT → FFT

This works even for a selected area of your image. When hovering the mouse pointer
over a pixel of interest in the FFT, Fiji will display its position in the FFT and the
respective distance in the real image. This can help you calibrate the magnification.

B.4 Image Stacks

Image stacks can be created from sequential images, while the slider in the window
of an image stack represents the «Z-axis» of the stack. You can create a projection
of all images in the stack by using:

Image → Stacks → Z-Project

When putting together the recorded partial diffraction patterns, choosing «Max In-
tensity» will let you create a single image containing the brightest parts of each single
image. This is useful for creating a nice full diffraction pattern from your partial
ones.

B.5 Radial and Line Profile

For your calibration you need to measure lengths in your images (e.g. cross-grating).
For proper measurements (including error estimation) you should use «Line Profiles».
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Draw a line across the image using the «line tool». Double clicking the tool button
lets you change the width of the line. You get a line profile under:

Analyze → Plot Profile

Clicking the «List» button in the profile window will give you the x and y coordinates.
You can export them (e.g. as .txt-file) and plot/analyze the profile in a software
of your choice. The «live» button in the profile window allows you rearrange the
drawn line in the image, while keeping the plot profile updated in real time. This is
especially helpful for the radial profile.

The radial profile is similar to the plot profile. It measures the mean intensity of
concentric circles as a function of the radius. Once you have installed the «Radial
Profile» plugin, fit a circle to the data (e.g. of diffraction patterns). Make sure you
press «Shift» so your circle becomes round and not elliptic. It is important that the
plugin knows where the center of the circle is located since this will define the zero
position of the radial profile. Be precise with fitting the circle. Otherwise the error
of the measurement increases. Make use of the «live» button to optimize the circle
position.
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C. Provided Samples

• Inorganic samples

– Gold (Au)
– Magnesium oxide crystals
– Gold/Palladium (Au/Pd 80:20)
– Platinum/Palladium (Pt/Pd 80:20)

• Biological samples

– Mouse muscle
– Infected amoeba
– Wasp (SEM)
– Butterfly (SEM)
– Pollen (SEM)

• Standard samples

– Cross-grating calibration sample with latex spheres (2160 lines/mm, ∅
0.261µm)

– Bovine catalase
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